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SEMESTER I 

S.

NO 
Part. 

COURSE 

CODE 
COURSE TITLE HRS 

CRE

DITS 

CIA 

Mks 

ESE 

Mks 

TOT 

MKs 

1.  I 

21TL1S1/ 

21RL1C1/ 
21DL1S1 

Language-Modern 
Literature/ French - Le 
Niveau Introductif/ 

Hindi 

5 3 40 60 100 

2.  II 

21EL1WB 
Basic Communicative 
English 

5 3 40 60 100 
21EL1WI 

Intermediate 
Communicative 

English 

21EL1WA 
Advanced 
Communicative 
English 

3. III 

19K1CC1 
Core Subject: 

Business Accounting 
6 4 40 60 100 

21K1CC2 Business Studies 6 4 40 60 100 

21K1AC1 

Allied Subject: 

Computer Applications 
in Business 

5 5 40 60 100 

4. IV 

19K1NME1 

Non-Major Elective 
(Offered to other 

major Students) 
Fundamentals of 

Costing 

2 2 40 60 100 

21G1VE 
Value Education: 

Personal Values 
1 1 40 60 100 

5.  21K1SLI1 

Self Learning 
Courses:  
Trends in Information 

Technology 

- 2 40 60 100 

   Total 30 22 320 540 800 



 

SEMESTER II 

S.

NO 
Part. 

COURSE 

CODE 
COURSE TITLE HRS 

CRE

DITS 

CIA 

Mks 

ESE 

Mks 

TOT 

MKs 

1. I 
21TL2S2/
21RL2C2/
21DL2S2 

Language - Ancient & 

Medieval Literature 

(Com) / French - Le 

Niveau/ Hindi 

5 3 40 60 100 

2. II 

21EL2WB 
English Communication 

Skills  

5 3 40 60 100 21EL2WI 
English For 

Empowerment  

21EL2WA 
English For Creative 

Writing  

3. III 

19K2CC3 
Core Subject: 
Advanced Accountancy 

6 4 40 60 100 

21K2CC4 
Programming in C 

(Theory & Practical) 
6 4 40 60 100 

21K2AC2 
Allied Subject: 

Discrete Statistics  
5 5 40 60 100 

4. IV 

19K2NME 

Non-Major Elective 
(Offered to other major 
Students) 

Fundamentals of 
Costing 

2 2 40 60 100 

21G2VE 
Value Education: 
Values for Life 

1 1 40 60 100 

5.  21K2SL1 
Self Learning Courses: 

Trends in Commerce 
- 2 40 60 100 

   Total 30 22   800 

 

  



SEMESTER III 

S.

NO 
Part. 

COURSE 

CODE 
COURSE TITLE HRS 

CRE

DITS 

CIA 

Mks 

ESE 

Mks 

TOT 

MKs 

1. II 19EL3WN English for Digital Era 5 3 40 60 100 

2. III 

19K3CC5 

Core Subject: 

Principles of Cost 
Accounting 

6 4 40 60 100 

21K3CC6 
Principles of RDBMS 
(Theory & Practical) 

4 3 40 60 100 

19K3CC7 
Principles of 
Management 

5 3 40 60 100 

19U3ACK3 Allied Subject: 

Principles & Practice of 
Banking (Offered to 
BBA) 

5 5 40 60 100 

3. IV 

19G3EE 
Environmental 

Education 
1 1 40 60 100 

19K3SB1 

Skill Based: 

Introduction to 

Banking 

2 2 40 60 100 

  
21UAD3E

S 

Value Education: 

Professional Ethics 
1 1 40 60 100 

4.  21K3SL1 
Self Learning Courses: 

Digital Commerce 
- 2 40 60 100 

   Total 29 24 360 700 900 

 

  



SEMESTER IV 

S.

NO 
Part. 

COURSE 

CODE 
COURSE TITLE HRS 

CRE

DITS 

CIA 

Mks 

ESE 

Mks 

TOT 

MKs 

1. II 19EL4WN 
English for Integrated 

Development 
5 3 40 60 100 

2. III 

19K4CC8 

Core Subjects: 

Principles of 
Management 
Accounting 

6 4 40 60 100 

21K4CC9 
Web Programming 

(Theory & Practical) 
4 3 40 60 100 

21K4CC10 Business Economics 5 3 40 60 100 

19U4ACK4 Allied Subject: 

Management 
Information System 
(Offered to BBA) 

5 5 40 60 100 

3. IV 

19G4EE 
Environmental 

Education 
1 1 40 60 100 

19K4SB2 
Skill Based: 

Practical Banking 
2 2 40 60 100 

4.  

21UAD4E

S 

Value Education: 

Personality 
Development 

1 1 40 60 100 

5.  21K4SLU1 
Self Learning Courses: 
Quantitative Aptitude 

- 2 40 60 100 

   Total 30 22 280 420 800 

 

  



SEMESTER V 

S.

NO 
Part. 

COURSE 

CODE 
COURSE TITLE HRS 

CRE

DITS 

CIA 

Mks 

ESE 

Mks 

TOT 

MKs 

1. III 

 

19K5CC11 

Core Subjects: 

Basics of Tax Laws & 

Practice 

 

5 
4 40 60 100 

19K5CC12 
E-Commerce 5 4 40 60 100 

19K5CC13 
Financial Accounting in 

Software Package with 

GST 

5 4 40 60 100 

21K5CC14 
Programming in Python 

(Theory & Practical) 
3 3 40 60 100 

 

19K5ME1 

19K5ME2 

Major Electives: 

1.Security Analysis 

2. Practical Auditing 

 

 

5 

 

 

5 

40 60 100 

2. IV  

19K5SB3 

19K5SB4 

Skill Based: 

Skills for Bank Exam  

Soft skills for Bank 

Employment 

 

2 

2 

 

2 

2 

40 60 100 

3.  
21UAD5E
S 

Value Education: 

Family Life Education  
1 1 40 60 100 

4.  19UAD5H
R 

Human Rights  1 2 40 60 100 

5.  21K5SLJ1 
Self Learning Courses: 

Emerging Trends and 

Technologies 

 

- 
2 40 60 100 

   Total 31 25 360 540 900 

 

  



SEMESTER VI 

S.

NO 
Part. 

COURSE 

CODE 
COURSE TITLE 

HR

S 

CRE

DITS 

CIA 

Mks 

ESE 

Mks 

TOT 

MKs 

1. III 

19K6CC15 

Core Subjects: 

Principles of Tax Laws & 
Practice 

 

3 

 

3 
40 60 100 

19K6CC16 Company Accounts 
2 1 40 60 100 

21K6CC17 
Business Research 
Method 

5 4 40 60 100 

 

19K6ME3 

 

19K6ME4 

 

19K6ME5 

 

19K6ME6 

Major Electives: 

Human Resources 
Management  

or 

Financial Management   

 

Enterprise Resource 
Planning  

Or 

Company Law & 
Practice  

 

 

5 

 

 

 

 

5 

 

 

5 

 

 

 

 

5 

40 60 100 

2. 

 

 

IV 

 

 

 

19K6SB5 

Skill Based: 

Skills for Verbal 

Reasoning  

Graphical Designing 

 

2 

 

2 

 

2 

 

2 

40 60 100 

21UAD6E

S 

Value Education: 
Life Skills 

1 1 
40 60 100 

3.  21K6SL1 Self Learning Courses: 

Business Organisation 
- 2 

40 60 100 

   TOTAL 25 25 
700 420 700 

 

21K6SB6 



I B.Com(CA) 

SEMESTER –I 

For those who joined in 2021 onwards  

 

COURSE DESCRIPTION 

This course enables the candidates to enhance their business skills. 

COURSE OBJECTIVES 

To gain in depth knowledge about how business activities are performed. 

UNITS 

 

UNIT –I  INTRODUCTION      (18 HRS.) 

Nature and scope of business-Classification of business activities-Social 

responsibility of business – Establishing new business – Forms of Business 

Organisation – Sole Proprietorship,partnetship,joint stock companies,co-

operative societies,public enterprises,MNC(Features,merits and demerits of 

each firm of business organisation)  

UNIT –II COMPANY FORMATION AND PROMOTION  (18 HRS.) 

Stages in promotion – types of companies – drafting of various documents – 

memorandum of association – articles of association – prospectus. 

UNIT –III  FOREIGN TRADE      (18 HRS.) 

Formalities with import and export trade- drafting of various documents 

used in foreign trade components, objective and its environment. 

UNIT –IV  STOCK EXCHANGE      (18 HRS.) 

Meaning and nature of stock exchange- role and feature of stock exchange. 

PROGRAMME 
CODE 

COURSE 
CODE 

COURSE 
TITLE 

HRS/WEEK CREDITS 

USCC 21K1CC2 

BUSINESS 

STUDIES 6 4 



 

UNIT –V  FINANCIAL INSTITUTIONS     (18 HRS.) 

Role and functions, types of financial institutions – 

IDBI,IFCI,ICICI,SFC,LIC,UTI,GIC 

UNIT –VI  DYNAMISM (Evaluation Pattern-CIA only)   

SEBI – Functions – Powers 

REFERENCES: 

1. Business organisation and management: M.C.Sahoo,S.Chand & co. 

New Delhi 

2. Modern business organisation and management: Sherlekhar & 

Sherlekhar, Himalaya Publishers 

3. Business Organisation: Y.K.Bhushan, S.Chand & co. New Delhi 

4. Fundamental of public enterprises: sahoo & Sahoo, Kalyani 

publishers, New Delhi 

  



I B.COM(CA) 

 SEMESTER –I 

For those who joined in 2021 onwards 

 

COURSE DESCRIPTION 

Office Automation refers to software used to digitally create, collect, 

store, manipulate, and relay office information. 

COURSE OBJECTIVES 

To gain basic knowledge about Computer devices, storage and office 

automation Essential for a modern office for day to day office management. 

UNIT I  MS-WORD        (15 HRS) 

MS Word - Working with File menu - Editing text documents -  

Formatting page & setting Margins - Using Tool bars- Formatting 

Documents - Setting Font styles, Font selection- - Setting Page style - 

Columns, Header & footer, Setting Footnotes & end notes – Shortcut Keys; 

Inserting manual page break, Column break and line break, Setting 

Document styles, Table of Contents, Page Numbering, date & Time, Author 

etc. Creating Tables- Table settings, Borders, Alignments, Insertion, 

deletion, Merging, Splitting, Sorting, and Formula, Drawing - Inserting 

ClipArt, Pictures/Files etc., Tools – Word Completion, Spell Checks, Mail 

merge, Templates, Printing Documents. 

UNIT II INTRODUCTION TO MS-EXCEL     (15 HRS) 

Introduction to Excel- Getting started – Explore window – Entering 

values – Move around – Save workbook – Create worksheet- Copy worksheet 

– Hiding worksheet – Delete worksheet – Close workbook - Formatting Cells 

PROGRAMME 
CODE 

COURSE 
CODE 

COURSE TITLE 
HRS/ 

WEEK 
CREDITS 

USCC 

 

21K1AC1 

 

COMPUTER 

APPLICATIONS 

IN BUSINESS 
5      5 



– Setting cell type – Merge & Wrap -Working with formula - Creating 

formulas – Formula reference – Using functions – Text functions – Date & 

Time - Statistical – Logical – Math & trig. Working with charts - Simple 

charts – Types of charts – Column – Bar – Pie- Line – Area – Doughnut – 

Creating chart – Editing chart – Pivot chart.  

UNIT III ADVANCED EXCEL       (15 HRS) 

Statistical Functions: Average-Average if-Median-Mode-Standard 

Deviation-Min-Max-Large-Small- Count-Count if.  

UNIT –IV MS ACCESS        (15 HRS) 

MS Access: Introduction-Planning a Database- Starting Access-Access 

Screen- Creating a New Database- Creating Tables- Working with Forms- 

Creating queries- Finding Information in Databases- Creating Reports- 

Types of Reports- Printing & Print Preview – Importing data from other 

databases viz. MS Excel etc. 

UNIT V MS-POWER POINT       (15 HRS) 

Creating a blank presentation- Power point screen: screen layout and 

Views- insert a new slide- applying design template- changing slide layout- 

reordering - slide show. Resizing a text box -Text box properties- Delete a 

text box- Bulleted lists- Numbered lists- Adding notes- Video and Audio- 

Adding text Editing options- Formatting text- Line spacing -Change case 

Spelling check- Adding clip art- Adding an image from a file- AutoShapes- 

WordArt- Backgrounds- preview Slide transitions Slide show options.  

UNIT –VI  DYNAMISM(Evaluation Pattern-CIA only)    

Resume and cover letter preparation - Creating E-Mail-Surfing jobs 

using search engines. 



MS-Word 

1. Working with  options in File Menu Opening, Saving Document. 
2. Working with  options in Edit Menu Moving, Copying, Finding and 

Replacing Document. 
3. Working with  options in Insert Menu Inserting Page no, Date and 

Time, Symbols, Auto Text ,Text Box, Hyperlink. 
4. Working with  Options in Format Menu Formating,Aligning,Bullets & 

Numbers,Change Case, 

5. Working with  options in Tools Menu Mail Merge,Spelling & 
Grammar,Word Count,Macro 

6. Working with  options in Table Menu Working with Tables 
MS-Excel 

  7.  To Open An existing Non Excel File 

  8.  To Save an Excel file as a Web page 

  9. To  Work with Worksheet 

10. To  Create Auto fills,Forms,Validation,Auto correction 

11.  To Work with formulae and Functions 

12.  To Create a chart 
MS-Power Point 

13.  To Create a slide using Animation Schemes,Custom 

Animation,Slide Transition, 
14. To  Create Advertisements Using all Options. 

MS Access 

15. To create Table creation using Wizard 

16. To Set Primary Key 
17. To perform  different types of Query’s 
18. To Create Forms 

19. To Create Reports 
20. To Create Macro With Message and conditions. 

TEXT BOOK: 

1. Learning Computer Fundamentals, MS Office and Internet & Web 
technology, Firewall Media publication,3rd edition 2016. 

REFERENCE BOOK: 
1. MS Office 2000 – Sanjay Saxena, Vikas Publishing House Pvt Ltd,4th 

Reprint 2005 

  



I B.Com(CA) 

 SEMESTER –I 

For those who joined in 2021 onwards 

 

COURSE DESCRIPTION 

The new trends and disruptive technologies in IT (Information Technology) 

emphasis is given to the way technologies create a competitive edge and 

generate business value. This year the course will have a special emphasis in 

cloud computing, artificial intelligence, internet of things, and big data. 

COURSE OBJECTIVES  

To impact the knowledge about the recent trends in IT 

UNITS 

 

UNIT –I  E-COMMERCE INTRODUCTION       

E-commerce Infrastructure: Introduction, E-commerce Infrastructure-An 

Overview, Hardware, Server Operating System, Software, Network Website 

UNIT –II  MANAGING THE E-ENTERPRISE  

Managing the e-Enterprise:  Introduction, e-Enterprise, Managing the e-

Enterprise, E-business Enterprise, Comparison between Conventional 

Design and E-organisation, Organisation of Business in an e-Enterprise 

UNIT –III  TRANSACTION PROCESSING SYSTEMS   

Transaction Processing Systems - Features of TPS -E-World: Features Of E-

Commerce - Importance Of E-Commerce - Types of Electronic Commerce - E-

Commerce Activities -E-Learning - E-Banking - E-Governance - E-

Agriculture- E-Logistics. 

PROGRAMME 
CODE 

COURSE 
CODE 

COURSE 
TITLE 

HRS/WEEK CREDITS 

USCC 21K1SLI1 

TRENDS IN 

INFORMATION 
TECHNOLOGY 

- 2 



UNIT –IV  TYPES OF WIRELESS SERVICES     

 Benefits - Working of Biometric Systems – Uses – Types - RFID: 

Components - Working of RFID - Advantages. Embedded Systems – 

UAV(Unmanned Aerial Vehicle) -  GPS - 3G - 4G - 5G - Wi-Fi - Wi-Max – 

Bluetooth-  Infrared Communication -  Firewall - Data Security and 

Cryptography - Parallel and Distributed Computing – VLSI - Smart Card. 

UNIT –V  BIG DATA         

Knowledge Management – CRM -  BPO – KPO – NLP - Artificial Intelligence -

Big data - Big data  Analytics – Cloud – Mobile - Internet of things - Image 

Processing - Nano technology - Semantic web - Social media - Soft 

Computing -Speech Recognition - Virtual Reality and Augmented reality - 

Third Eye: A Shopping Assistant for the Visually Impaired - Machine 

Learning - Neural Network. 

UNIT –VI  DYNAMISM(for CIA only)  

Applications of wireless services 

TEXT BOOK: 

1) Peter Nortorn‟s, “ Introduction to Computer”, TMH, 2004, ISBN-0-07-05-

3142-0 

2) ChetanShrivastava“ Fundamentals of Information Technology”, Kalyani 

publishers, 2002, 

ISBN-81-7663-576-6 

3) DrMadhulikaJain,“Information Technology Concept”, BPB,2006,ISBN – 

81-7656-276-9 

4) Alexis and Mathews Leon, “Fundamentals of Information Technology”, 

Leon Press, ISBN 

:8182090105 

5) Verma,“Computer, Internet & Multimedia – Dictionary”, Universities Press 

REFERENCE BOOKS: 

1) Suresh K. Basandra, Computers Today, Galgotia Publications Pvt Ltd., 

New Delhi. 



2) Computer Applications In Business, R. Parameswaran 

3) ITL Education Solutions Limited, Introduction to Information 

Technology,PearsonEducation,New Delhi. 

4) Perry, P.J., Worldwide Web secrets, Comdex Publishing, New Delhi.. 

5) Davis,Gordon.B, and Olson, Malgrethe H., Management Information 

systems, Mcgraw Hill Book company 

6) Emerging Trends in Information Technology, Mrs. Jigisha D. Pardesi 

7) Textbook of Emerging Trends in Information Technology Paperback – 

2011,by Ravi P Patki 

8) E-world: Emerging Trends in Information Technology. by 

ArpitaGopal&Chandrani Singh 

  



II B.Com(CA) 

SEMESTER –II 

For those who joined in 2021 onwards 

 

COURSE DESCRIPTION 

C is a high level programming language developing a portable 

applications. 

COURSE OBJECTIVES 

This course enables the students to gain knowledge of applying 

computers to solve problems and skills in programming. 

UNITS 

UNIT I  INTRODUCTION TO C      (18 HRS) 

 

The C character set - Identifiers and Keywords - Data types - 

Constants - variables -  types of operators - input and output- Get and put 

function.  

UNIT II CONTROL FLOW STATEMENTS     (18 HRS) 

Branching - Looping - Switch - Break - Continue – Go to statements. 

UNIT III FUNCTIONS AND ARRAYS      (18 HRS) 

 Defining a function - Accessing a function –Passing arguments to 

function - Recursion - Library Function -Defining and processing an Array - 

Passing arrays to function -  Arrays and strings. 

 

UNIT –IV STRUCTURES AND UNIONS     (18 HRS) 

Defining a structure – Initializing a structure -Processing a structure - 

Passing structures to functions - Unions. 

UNIT V FILE MANAGEMENT IN C      (18 HRS) 

Introduction – Defining and opening a file – Closing a file – Input/ 

output operations on files – Error handling during I/O operations – Random 

PROGRAMME 
CODE 

COURSE 
CODE 

COURSE TITLE HRS/WEEK CREDITS 

USCC 21K2CC4 

PROGRAMMING 

IN C (THEORY 
& PRACTICAL) 

6 4 



access to files. 

UNIT –VI  DYNAMISM(Evaluation Pattern-CIA only)    

Introduction – Understanding pointers – Declaring pointer variable. 

PROGRAM LIST: 

1. To perform arithmetic operation 

2. To find simple interest and compound interest.   

3. To find whether the given number is positive or negative. 

4. To find whether the given number is odd or even. 

5. To check for prime numbers. 

6. To find the factorial of the given number. 

7. To generate Fibonacci series. 

8. To create a multiplication table. 

9. To find whether the given number is palindrome or not. 

10. To arrange the numbers in ascending order. 

11. To Implement string functions 

12. To perform matrix addition 

13. To prepare Student mark list using structures. 

14. To perform employee payroll processing using structures. 

15. To perform file copy. 

TEXT BOOK: 

Programming in ANSI C – E. Balaguruswamy, 7th edition, Tata McGrawHill 

publications,2017. 

 

REFERENCE BOOK: 

1. Working with C – YashavantKanetkar, 3rd edition, BPB Publications, 

2003. 

2. Theory and problems of Programming in C - Byron S. Gottfried, 1989. 

  



I B.COM(CA) 

 SEMESTER –II 

For those who joined in 2021 onwards 

 

COURSE DESCRIPTION 

            This course is an introduction to descriptive statistics,measures of 

central tendency, measures of dispersion,correlation, and regression. 

COURSE OBJECTIVES 

To gain an in-depth knowledge about the application of various methods in 

Statistics. 

UNITS 

UNIT  I INTRODUCTION & MEASURES OF CENTRAL TENDENCY  

[15 HRS] 

 Introduction of statistics - Characteristics– Requisite of a good average 

– Mean               Simple Average: (Individual, Discrete, Continuous) - 

Weighted Average, Combined mean– Median (Individual, Discrete, 

Continuous) – Mode (Individual, Discrete, Continuous) - Diagrammatic and 

graphic presentation of data using  Excel - Calculation of averages using 

Excel.  

UNIT  II MEASURES OF DISPERSION    [15 HRS] 

 Objects – Properties – Absolute and Relative measures – Range  - 

Quartile deviation – Mean deviation – Standard deviation – Variance. 

UNIT III CORRELATION                                            [15 HRS] 

PROGRAMME 
CODE 

COURSE 
CODE 

COURSE 
TITLE 

CATEGORY 
HRS/ 

WEEK 
CREDITS 

USCC 

 

21K2AC2 

 

DISCRETE  

STATISTICS 

 

THEORY&  
PROBLEM 

 

5      5 



 Introduction -   Co-efficient of correlation and Causation - Types of 

correlation - Positive and Negative - Simple - Linear and Non-linear methods 

- Scatter Diagram - Graphic - Karl Spear son’s Co-efficient of correlation  - 

Rank Correlation Co-efficient - Concurrent Deviation method.. 

UNIT IV REGRESSION ANALYSIS                                     [15 HRS] 

           Introduction  - Methods of regression analysis – Regression Equation 

of X on Y - Regression Equation of Y on X –Deviations Taken  from 

Arithmetic Means of X and Y - Deviations Taken  from Assumed Means – 

Regression Equations In Case of Correlation Table – Standard Error of 

Estimate. 

UNIT V INDEX NUMBERS & TIME SERIES                    [15 HRS] 

Index Number: Introduction- Types, Aggregate - Weighted, Price relatives - 

Tests - Fixed base, Chain base, Shifts, Consumer price index, Aggregate, 

Family budget method. Time series:  - Moving average, Method of least 

squares.(Self Study) 

TEXT BOOK: 

1. Statistical Methods           -  S.P. Gupta, 

28thedition,Sultanchand&sons,New Delhi, 2009. 

REFERENCES: 

 1. Statistics        -  R.S.Pillai& V.Bhagavathi,7th edition, Sultan chand& 

sons, New Delhi. 

  



I B.Com(CA) 

 SEMESTER –II 

For those who joined in 2021 onwards 

 

COURSE DESCRIPTION 

Students gain knowledge of advanced e-banking transactions, computer 

billing and formation of MSME through SHGs 

COURSE OBJECTIVES 

To impart the knowledge on current trends in business 

UNITS 

UNIT I E-BANKING 

Banking Practice of E-Banking- Steps in conversion of personal 

account into online Account- ATM operations-NEFT and RTGS transactions.  

UNIT II INSURANCE 

Definition and Nature of insurance – Functions of Insurance – 

Principles of Insurance - Evolution of insurance – Kinds of Insurance – 

Types of Insurance organizations in India - Role and importance of 

insurance  

UNIT III ONLINE TRADING  

Practice of Online Trading Technical Analysis – Important Jargons in 

Online trading  

UNIT IV  COMPUTER BILLING SYSTEM 

PROGRAMME 
CODE 

COURSE 
CODE 

COURSE 
TITLE 

HRS/WEEK CREDITS 

USCC 21K2SL1 
TRENDS IN 

COMMERCE 
- 2 



Meaning of Billing System –How to set Billing System in Business 

(Recommended Departmental Stores Bakeries-Hotels) Purchasing goods 

online through any one Apps (Amazon or E-bay or Flipkart)  

UNIT V SELF HELP GROUPS 

 Self Help Groups in India-Meaning-Need & Objectives- Procedure  

UNIT VI  DYNAMISM(Evaluation Pattern-CIA only)  

Online Payment-Different Types of Payment Cards- ATM Operations 

REFERENCES: 

1.Insurance Principles and Practice  - M.N. Mishra, 2014. 

 
2. Banking Theory Law and Practice – Dr. S. Gurusamy, Tata McGraw – Hill, 

New Delhi, 20th Edition (Reprint, 2015) 

  



II B.Com(CA) 

SEMESTER –III 

For those who joined in 2021 onwards 

 

COURSE DESCRIPTION 

A Relational database management system(RDBMS) is a database 

Management system (DBMS) that is based on the relational model 

represented as table. 

COURSE OBJECTIVES 

To reveal the concept of relational database and to provide basic 

exposure to oracle. 

UNITS 

UNIT I - INTRODUCTION TO DBMS      (18 HRS) 

Introduction- Characteristics of data in database-Database 

management system-Types of DBMS-Hierarchical model-Network model-

Relational Model.  

UNIT II - NORMALIZATION       (18 HRS) 

Introduction – Keys-Relationship – normalization -First normal form- 

Second normal form –Third normal form- BCNF-Fourth normal form. 

UNIT III - INTRODUCTION TO SQL * PLUS    (18 HRS) 

Oracle data type – DDL (Create, Alter, Drop) – DML(Insert, Update, 

Delete, Select) – DCL(Grant ,Revoke) – Constraints(Primary key, Foreign key, 

Not null, Unique)-Joins. 

 UNIT IV - DATA MANIPULATION AND CONTROL   (18 HRS) 

PROGRAMME 
CODE 

COURSE 
CODE 

COURSE TITLE HRS/WEEK CREDITS 

USCC 
21K3CC6 PRINCIPLES OF 

RDBMS(THEORY 

& PRACTICAL) 

6 4 



Set operations: Union, intersect and minus - Nested queries – 

functions –Arithmetic function – character Function - date Functions – 

views. 

UNIT V - PL/SQL         (18 HRS) 

Introduction to PL/SQL - block structure - data types - variables and 

constants assignment and expressions conditional and iterative control - 

writing PL/SQL Program- procedures - functions. 

UNIT VI - DYNAMISM(Evaluation Pattern-CIA only)    

Data modeling - Modeling Three Schema Architecture- Entity Relationship 

(ER) model- Entities Attributes and Relation (EAR) models- Entity Relationship 

Diagrams. 

SELF STUDY: 

Characteristics of data in database - Keys - character Function - date 

Functions. 

PROGRAM LIST: 

1. Program using DDL Commands 

2. Program using DML Commands 

3. Program using Constraints 

4. Simple select query 

5. Ordering of the result 

6. Grouping the result 

7. Sub queries 

8. Creation of views 

9. To find greatest among three numbers 

10. To find factorial of a given number 

11. To generate the Fibonacci Series 

12. To check prime number 

13. To find reverse of number using Procedure 

14. To find NCR using function 

TEXT BOOKS: 



1. Database management Systems  - Alexis Leon & Mathews Leon, L&L  

Consultancy services Pvt.Ltd ,2008. 

2. ORACLE: The complete reference - George Koch & Kevin Loney, Tata 

McGraw Hill, 2004. 

REFERENCE BOOK 

1. Introduction to Database Management - Naveen Prakash, Tata 

McGraw Hill,Tata McGraw Hill, First reprint, 2006. 

  



II B.Com(CA) 

 SEMESTER –III 

For those who joined in 2021 onwards 

COURSE DESCRIPTION 

This course enables the activity of buying or selling of products on 

online services or over the Internet.  

COURSE OBJECTIVES 

This course enables the students to get in-depth knowledge about how 

commerce is done electronically by means of Internet. 

UNITS 

UNIT I : E-BUSINESS 

History  - Business model - Revenue model - E-commerce - Security – 

Advantages – Disadvantages – ERP Systems – CRM Softwares - Extension of 

E-Commerce and M-Commerce 

UNIT II : E-COMMERCE MODELING LANGUAGE 

The members of ECML –Cyber Cash – Master Card – IBM – Microsoft – Visa 

International -  Customer Dropout Behaviours - Customer's Privacy 

Expectations  - Cashless society 

UNIT III : DIGITAL ECONOMY 

Gig Economy - Framework for Global Electronic Commerce - Digital 

platforms - Economic Impact - Impact on Retail 

UNIT IV : MOBILE COMMERCE 
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Products and services - Mobile money transfer - Mobile ticketing - Mobile 

vouchers, coupons and loyalty cards - Mobile brokerage - Auctions - Mobile 

marketing and advertising - App commerce 

UNIT V : SHOPPING CART SOFTWARE AND APPS 

History – Components – Types - Open source software - Licensed software - 

Hosted service - U-Commerce Apps - Code First – Heat Map – Ad Hub – MVC 

– Raptor – Webshipr – Feed Generator – Inconceivable – Cray Fish – Gift 

Cards 

UNIT –VI  DYNAMISM(for CIA only) ( HRS.) 

M-commerce trust, security, and payment  

REFERENCES: 

1. E.Brian Mennecke, J.Troy Strader, “Mobile Commerce: Technology, 

Theory and Applications”, Idea Group Inc., IRM press, 2003. 

2. Ravi Kalakota, B.Andrew Whinston, “Frontiers of Electronic Commerce”, 

Pearson Education, 2003. 

3. P. J. Louis, “M-Commerce Crash Course”, McGraw- Hill Companies 

February 2001. 

4. Paul May, “Mobile Commerce: Opportunities, Applications, and 

Technologies Of Wireless Business” Cambridge University Press March 2001. 

  



II B.COM(CA) 
SEMESTER –IV 

For those who joined in 2021 onwards 

 

 

COURSE DESCRIPTION 

Web technology can be defined as the interface between web server 

and web clients. 

COURSE OBJECTIVES 

This course enables the students to gain expertise in Web designing  

and techniques for improving the accessibility of an HTML document 

 

UNITS 

UNIT I – INTRODUCTION          (18 HRS)                                                                          

Introduction – About Internet-History of the Internet-Internet Services 

and Accessibility-Uses of the Internet-Protocols-Web Concepts. 

UNIT II - INTERNET PROTOCOLS                             (18 HRS) 

Internet Protocols-Host Names-Internet Applications and Application 

Protocols-Email protocols-SMTP-POP-IMAP. 

UNIT III - HTML(HYPERTEXT MARKUP LANGUAGE)               (18 HRS)  

SGML-Outline of an HTML Document-Head Section-Body Section-

Html Forms 

UNIT IV – JAVASCRIPT                                                        (18 HRS)  

Language Elements-Objects of JavaScript-Other Objects-Arrays. 

UNIT V - DYNAMIC HTML(DHTML)          (18 HRS) 

PROGRAMME 
CODE 

COURSE 
CODE 

COURSE TITLE 
HRS/ 

WEEK 
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   21K4CC9 
WEB PROGRAMMING 

(Theory & Practical) 

6 4 



Cascading Style Sheets (CSS)-Coding CSS-Properties of Tags-Property 

Values-Other Style Properties-In-Line Style Sheets-Embedded Style Sheets-

External Style Sheets-Grouping-Class as Selector-ID as Selector-Event 

Handling-Filters and Transitions. 

UNIT VI - DYNAMISM(Evaluation Pattern-CIA only)           

Creating simple static web pages for college web site 

SELF STUDY : 

About Internet-History of the Internet. Html-Head Section-Body Section. 

PROGRAM LIST: 

1. Simple programs in HTML 

2. Digital India web site Designing  in HTML 

3. Simple  programs in JavaScript 

4. Button animation in JavaScript 

5. To display the Digital clock in JavaScript 

6. Mouse over the words to see the cursor change in DHTML CSS 

7. To set the Watermark in DHTMLCSS 

8. Mouse over the squares and the background color will change In 

DHTML CSS 

9. To Click to turn on/off the light using DHTML CSS 

10. To Blink the text in DHTML Text 

TEXT BOOK: 

1. Web Technology (A Developer’s Perspective) -,Published by Asoke K. 

Ghosh,PHI Learning Private Limited,N.P. Gopalan and J.Akilandeswari, 

2nd edition, 2014. 

  



 

REFERENCE BOOKS: 

1. Internet and Web Design -published by Firewall Media -Ramesh 

Bangia, Second Edition 2005. 

2. Internet Technology and Web design -Published by Tata McGraw Hill 

Education  Private Limited-First Reprint @ 2011 

  



II B.COM(CA) 

SEMESTER –IV 

For those who joined in 2021 onwards 

 

 

COURSE DESCRIPTION 

This course introduces economic concepts and principles that 

facilitate best decision making of any business.  

 

COURSE OBJECTIVES 

To impart the knowledge about the economic theory and procedure 

which help to arrive at the right business decision. 

UNITS 

UNIT I: MANAGERIAL ECONOMICS:      (15 HRS) 

Managerial Economics – Wealth, Welfare and Scarcity Definitions - 

Concepts of National Income – Methods of calculating National Income - 

Difficulties in Measurement- Business Cycle – phases – boom – recession – 

depression – recovery - inflation and deflation. 

UNIT II: UTILITY, DEMAND AND SUPPLY:             (15 HRS) 

Law of Diminishing Marginal Utility –Illustration – Assumption – 

Exception – Importance- - The Law of Equi-Marginal Utility or the Law of 

Maximum Satisfaction. 

Demand function. – demand schedules and demand curves – Reasons 

for downward sloping demand curve – Exception to the Law of Demand 
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Elasticity of Demand – Price Elasticity of Demand – Income Elasticity 

of Demand - Cross Elasticity of Demand- Demand Forecasting- Methods of 

demand forecasting- Supply Function: Elasticity of Supply 

UNIT III: COST, REVENUE AND PRODUCTION FUNCTION   (15 HRS) 

Cost and Revenue concepts -opportunity Cost – Break even analysis – 

Production function - Laws of variable proportions – Laws of Returns to 

Scale 

UNIT IV: MARKETS AND PRODUCT PRICING                           (15 HRS) 

Types: Perfect Competition - Monopoly - Monopolistic Competition - 

Oligopoly – Features and Price determination 

UNIT V:FACTORS OF PRODUCTION AND FACTOR PRICING       (15 HRS) 

Land- Labour- Capital- Organisation - Ricardian Theory of Rent- Malthusian 

Theory of Population  

UNIT –VI  DYNAMISM(Evaluation Pattern-CIA only)   

Case study of Production pattern - Case study of Different market 

conditions- Case study of Life cycle of a product - Video shooting of markets 

- Case study of Cost and revenue of any company - Survey of pricing in 

Canteen  -Survey of Pricing in different markets - Study of consumption 

pattern - Survey of Factor payments in different companies (Govt and 

private) 

REFERENCE BOOKS: 

1.      Managerial economics –Dr.S. S.Sankaran,(2013 Edition),7th edition. 

 Margham Publication. Economics  Samuelson & Nordhaus –, Tata McGraw 

Hill.  

2.      Managerial Economics G.S.Gupta –, Tata McGraw Hill.  

3.      Managerial Economics Joel Dean –, Mote & Paul.  

4.      Micro Economic Theory D.N. Dwivedi –, Vikas Publishing House.  

5.      Managerial Economics Wali and Kalkundrikar . 

6.      Managerial Economics ,Varshney & Maheswari –, Sultan Chand & Son 

 

 

 

 

 



II B.Com(CA) 

 SEMESTER –IV 

For those who joined in 2021 onwards 

 

COURSE DESCRIPTION 

To impart knowledge on the quantitative aptitude problems so as to improve 

the problem solving skills of students. 

COURSE OBJECTIVES; 

1. Understand the various quantitative aptitude problems 

2. Analyse the data and draw interpretations 

3. Gain knowledge and have ability to solve aptitude problems with great 

confidence 

 

UNITS 

UNIT-I:  QUANTITATIVE APTITUDE – I  

  Number System - Simplification – HCF & LCM of Numbers – Number 

Test. 

UNIT-II:   QUANTITATIVE APTITUDE – II 

Averages – Percentage – Ratio & Proportion 

UNIT-III:   QUANTITATIVE APTITUDE – III 

Problems based on Ages - Simple Interest - Compound Interest – Time and 

Work 

UNIT-IV:  QUANTITATIVE APTITUDE – IV 

Pipes & System – Mensuration – Algebra 

UNIT – V  QUANTITATIVE APTITUDE – V 

PROGRAMME 
CODE 

COURSE 
CODE 

COURSE TITLE HRS/WEEK CREDITS 

USCC 21K4SLU1 
QUANTITATIVE 

APTITUDE 
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Progression – Logarithm – Permutation and Combination 

UNIT –VI  DYNAMISM (for CIA only)   

Solving recent IBPS-RRB and SSC Question papers 

TEXT BOOKS: 

1. STATE BANK OF INDIA RECRUITMENT OF CLERICAL STAFF – 

Unique  Publishers New Delhi 

2. BANK CLERKS’ EXAMINATION   - Unique Publishers New Delhi 

  



III B.COM(CA) 

SEMESTER –V 

For those who joined in 2021 onwards 

 

COURSE DESCRIPTION 

Python is an interpreted, high-level, general-purpose programming 

language. It provides constructs that enable clear programming on both 

small and large scale. 

COURSE OBJECTIVES 

The course is designed to provide an introduction to Python 

Programming and is intended to empower students to learn the Python 

programming language which used to design applications. 

UNITS 

UNIT I -  INTRODUCTION TO PYTHON           (15 HRS) 

 History -Features -Setting up path – Literal constants – Variables 

and identifiers – Data types – Operators – Operations on strings – Other data 

types.  

UNIT II -  DECISION CONTROL STATEMENTS          (15 HRS) 

 Conditional statements – Loop structures - Iterative statements – 

Nested loops – Break – Continue – Pass – Else used with loops  

UNIT III - FUNCTIONS, MODULES AND PACKAGES       (15 HRS) 

 Function definition – Function call - Variable scope – Return 

statement – More on defining functions – Lambda function – Documentation 

strings - Recursive functions – Modules – Packages – Standard library 

modules – Globals()- Locals() – Reload()- Function redefinition. 

PROGRAMME 
CODE 

COURSE 
CODE 

COURSE TITLE 
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UNIT IV -  STRINGS AND LIST MANIPULATIONS          (15 HRS) 

Strings: Concatenating - Appending - Multiplying strings – Strings are 

immutable – Formatting operator – Built in string functions -  Slice – ord() 

and chr() – In and not in functions – Comparing strings – Iterating string. 

List: Accessing values – Updating values – Nested list – Cloning – Basic list 

operations – List methods  

UNIT V -  FILE HANDLING                          (15 HRS) 

File:  File  path – Types of files – Opening and closing files – Reading 

and writing files – File position – Rename and delete a file.  

UNIT VI - DYNAMISM(Evaluation Pattern-CIA only)                    

Computing Loan Calculator– Computing distance – Computing Tax. 

SELF STUDY:  

Literal constants – Variables and identifiers – Data types-- Iterative 

statements – Nested loops- Function definition – Function call. 

 

PROGRAM LIST: 

 

1. Write a program to swap two variables without using third variable. 

2. Write a program to compute the area of triangle when the three sides 

are given. 

3. Write a program to compute whether a given number is an Armstrong 

number. 

4. Write a program to convert a given binary number to its equivalent 

decimal number. 

5. Write a program using functions to generate the Floyd’s triangle for a 

specified number of rows. 

6. Write a program to check whether an entered string is a palindrome or 

not. 

7. Write a program to sort words in alphabetical order. 



8. Write a program to compute mean, variance and standard deviation 

using List. 

9. Write a program to copy contents of an input file to an output file.  

TEXT BOOK: 

1. Python Programming – ReemaThareja , Oxford University Press , 

2017. 

REFERENCE BOOKS: 

1.     Think Python – Allen B.Downey ,O’Reilly Publications, 2nd Edition. 

2.     Exploring Python – Timothy A.Budd, Tata McGraw Hill, 2017 

  



III B.Com(CA) 

 SEMESTER –V 

For those who joined in 2021 onwards 

 

COURSE DESCRIPTION 

This course explores the current and potential future impacts of new, 

emerging, and rapidly evolving technologies on organizations and their 

operations across a range of industries and sectors. 

COURSE OBJECTIVES 

Students can examine the challenges and opportunities in new and emerging 

technologies. This course investigates how to identify and implement a new 

technology that will solve a problem in an organization. 

UNITS 

 

UNIT I : THE BIRTH OF A NEW PARADIGM 

Analyze interactions – Resource Utilization – Changing Patterns – tracking 

tools - Healthcare and safety monitors - procure-to-pay (P2P) - real-time 

updates on goods ordered, delivered 

UNIT - II BLOCKCHAIN 

History – Versions - BitCoin – Miners - Working - Uses – Need – Building 

Bitcoin Block Chain – Block Chian Bit Coin Cash – Wallets 

UNIT - III  EDGE COMPUTING  

 AWS (Amazon Web Services ) - Microsoft Azure - Google Cloud Platform - 

Customer Data Platforms (CDP) 

PROGRAMME 

CODE 

COURSE 

CODE 
COURSE TITLE HRS/WEEK CREDITS 

USCC 21K5SLJ1 
EMERGING 

TRENDS AND 
TECHNOLOGIES 

- 2 



UNIT- IV  5G  

Mobile gamers - Reliable Telecommunication - Internet-connected 3D 

printing - augmented reality - virtualized copy - Business Benefits of Digital 

Twins 

UNIT - V SECURITY MECHANISMS 

General Data Protection Regulation (GDPR)  - Thwarting Cyber Criminals - 

 Internet of Behaviors (IoB) - Location Tracking -  Bigdata - Facial 

Recognition - Digital Security Asset - Privacy and Confidential Computing 

UNIT –VI  DYNAMISM (for CIA only)   

Case studies, and potential strategies for block chain  

REFERENCE BOOK :   

1. Advances in Emerging Trends and Technologies:  Miguel Botto-

Tobar (Editor), Joffre León-Acurio (Editor), Angela Díaz 

Cadena (Editor), Práxedes Montiel Díaz (Editor) Volume 2 (Advances in 

Intelligent Systems and Computing, 1067) 1st ed. 2020 Edition 

2. The Basics of Bitcoins and Blockchains: An Introduction to 

Cryptocurrencies and the Technology that Powers Them 

(Cryptography, Crypto Trading, Derivatives, Digital Assets) Hardcover 

– Illustrated, Antony LewisSeptember 15, 2018 

3. Beginning Azure IoT Edge Computing: Extending the Cloud to the 

Intelligent Edge : David Jensen 

  

https://www.ishir.com/big-data.htm
https://www.amazon.com/s/ref=dp_byline_sr_ebooks_4?ie=UTF8&field-author=Pr%C3%A1xedes+Montiel+D%C3%ADaz&text=Pr%C3%A1xedes+Montiel+D%C3%ADaz&sort=relevancerank&search-alias=digital-text


III B.Com(CA) 

SEMESTER –VI 

For those who joined in 2021 onwards 

 

COURSE DESCRIPTION    

Identify and discuss the complex issues inherent in selecting 

a research problem, selecting an appropriate research design, and 

implementing a research  

COURSE OBJECTIVES 

1. To familiarise students with basic of research and the research process. 

2. To help students in conducting research work and making research 

projects. 

UNITS 

UNIT –I  INTRODUCTION      (15 HRS.) 

Business research Definition- Types of business Research, Scientific 

Investigation: The Building Blocks of Science in Research The Language of 

Research Concepts, Constructs, Definitions, Variables, Proportions and 

Hypothesis, Theory and Models, Technology and Business Research: 

Information needs of Business- Technologies used in Business Research: 

The Internet, E-mail, Browsers and Websites. 

UNIT –II THE RESEARCH PROCESS     (15 HRS.) 

Problem Identification: Broad Problem Area- Preliminary Data Gathering, 

Literature Survey- Online Data Bases useful for Business Research- Problem 

Definition- Theoretical Framework- Components of Theoretical Framework- 

Hypothesis Development- Statement of Hypothesis- Procedure for Testing of 

Hypothesis. 
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UNIT –III THE RESEARCH DESIGN     (15 HRS.) 

Types Of Research Designs: Exploratory, Descriptive, Experimental Designs 

And Case Study- Measurement of Variables- Operational Definitions And 

Scales- Nominal and Ordinal Scales Rating Scales- Ranking Scales- 

Reliability and Validity- Content Validity, Criterion Related Validity and 

Construct Validity. 

UNIT –IV COLLECTION AND ANALYSIS OF DATA  (15 HRS.) 

Sources of Data- Data Collection Methods- Interviews: Structured Interviews 

and Unstructured Interviews- Face to Face and Telephone Interviews- 

Observational Surveys- Questionnaire Construction: Organizing Questions- 

Structured and Unstructured Questionnaires- Guidelines for Construction of 

Questionnaires, Data Analysis: An Overview of Descriptive, Associational and 

Inferential Statistical Measures.  

UNIT –V THE RESEARCH REPORT      (15 HRS.) 

Components – The Title Page- Table of Contents- The Executive Summary- 

The Introductory Section- The Body of the Report- The Final Part of the 

Report- Acknowledgments- References- Appendix- Guidelines for Preparing a 

Good Research Report- Oral Presentation- Visual Aids- the Presentation and 

Handling Questions. 

UNIT VI : DYNAMISM 

Research Gap- Identifying Research Gap-Research Gap in Literature Review 

REFERENCES: 

1. Uma Sekaran, Research Methods for Business- A Skill Building 

Approach. John Wiley & Sons (Asia) Pvt. Ltd Singapore, 2003 

2. William G. Zinkmund. Business Research Methods. Thomson Business 

Information India Pvt. Limited Bangalore, 2005 

  



III B.Com CA 

SEMESTER –VI 

For those who joined in 2021 onwards  

 

COURSE DESCRIPTION 

Graphic Design is a course that explores graphic communication through 

the understanding of the elements and principles of design; as well as, 

the design process, from idea development through the final execution of a 

document. 

COURSE OBJECTIVES: 

To enhance the visual communication and essential graphics 

knowledge to create object-based logo's designs, company identities, 

brochures and catalogs with fine skills and depth of creativity.  

UNITS 

UNIT –I  BASICS OF CORELDRAW     ( 6 HRS.) 

Introduction-Getting Started-Creating A New File - Title Bar-Menu Bar-Work 

Area-Printable Page-Property Bar-Page Counter Bar-Colour Palette-Toolbox-

Status Bar-Drawing Figures- Lines-Ellipse-Circles-Rectangle-Square-

Polygon-Saving-Closing-Opening-Views-Normal View-Preview-Wire Frame 

View-Draft View-Zoom-View Manager-Creating a View. 

UNIT –II  DRAWING       ( 6 HRS.) 

Introduction - Toolbox-Selecting an Object-Resizing an Object-Moving an 

Object-Changing the Shape-Combining Two Objects-Skewing-Welding the 
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Objects-Blending-Curve Lines- Straight Lines-Continuing a Line-View 

Mode-Changing-Media Tool-Rotating An Object- Grouping-Fill Tool Fly Out-

Filling-Spray Mode. 

UNIT –III  TEXT        (6 HRS.) 

Introduction-Text Tool-Entering Artistic Text-Entering Paragraph Text-

Converting Text- Formatting Text-Changing the Font Size-Arranging 

Objects-Ordering The Objects-Changing the Font-Bullets-Decorating the 

Text-Webdings-Text Editor-Opening-Changing the Alignment- Type Style-

Spell Checking-Grammer-Searching Synonyms-Find-Replace-Editing-

Kerning- Formatting Characters. 

UNIT –IV  IMAGE        (6 HRS.) 

Bitmap Images-Vector Image-Resizing-Rotating-Skewing-Moving-Cropping-

Importing Images-Adding Special Effects-Converting to Bitmap-Exporting 

Images. 

UNIT –V  PAGE LAYOUT      (6 HRS.) 

Changing the Page Size-Changing the Layout-Applying Styles-Applying 

Bitmaps to the Background - Changing the Background-Adding a Page 

Frame-Moving Between Pages. 

UNIT – VI: DYNAMISM(Evaluation Pattern-CIA only)           (6 HRS) 

Creating invitations – Creating Logo & Business Cards 

  



List of Programs 

1. Creating a logo using Corel Draw 

2. Create Flyer using Corel Draw 

3. Create simple Leaves with Corel draw. 

4. Create 3d star in Corel Draw  

5. Creating a realistic looking Candle design using Corel Draw 

6. Create Taj Mahal in Corel Draw 

7. Combine intersect trim in Corel Draw  

8. Corel Draw Exercise to create Text Effect 

9.  Creating Brochure using Corel Draw  

10. Create a banner using Corel Draw  

 

TEXT BOOKS: 

1. CorelDRAW X8: The Official Guide, Gary David Bouton, McGraw-Hill 
Education 
 

REFERENCE BOOKS: 

1.Coreldraw for Dummies, Deke McClelland, Julie Adair King, Hungry 

Minds Inc,U.S, 20 March 1997 
  



III  B.Com(CA) 

SEMESTER – VI 

For those who joined in 2021 onwards 

 

COURSE DESCRIPTION 

This course provides a clear understanding of the fundamentals of 

company law is critical for anyone who is looking to understand corporate 

and Business. 

COURSE OBJECTIVES 

To gain in-depth knowledge and techniques in the field of Corporate 

and Business. 

UNITS 

UNIT-I – INTRODUCTION 

Concepts of  Business, Trade , Industry and Commerce – Features  of  

Business -Trade  Classification - Aids to Trade – Industry – Classification – 

Relationship  of  Trade, Industry and Commerce.  

UNIT II- BUSINESS FUNCTIONS AND ENTREPRENEURSHIP   

Functions of Business and their relationship - Factors influencing the 

choice of suitable form of organization – Meaning of Entrepreneurship – 

Characteristics of a good entrepreneur - Types – Functions of  

Entrepreneurship. 

UNIT –III – FORMS OF BUSINESS ORGANIZATIONS  
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Sole Proprietorship – Meaning – Characteristics – Advantages and 

Disadvantages – Partnership - Meaning – Characteristics- Kinds of partners 

– Advantages and Disadvantages – Partnership Deed – Hindu-undivided 

Family – Cooperative Societies.  

UNIT-IV- JOINT STOCK COMPANY  

Joint Stock Company – Meaning – Characteristics –Advantages – 

Kinds of  Companies  - Differences between Private Ltd and Public Ltd 

Companies.  

UNIT-V- COMPANY INCORPORATION  

Preparation of  important Documents for incorporation of Company – 

Memorandum of Association – Articles of Association – Differences Between 

Memorandum of Association and Articles of Association  - Prospectus and 

its contents. 

TEXT BOOK:- 

1. Y.K.Bushan, Business organization and Management, Sultan Chand. 

REFERENCE BOOKS  

1. C.D.Balaji and G. Prasad, Business Organization - Margham 

Publications, Chennai. 

2. R.K.Sharma and Shashi K Gupta, Business Organization - Kalyani 

Publications. 

3. C.B.Guptha, Industrial Organization and Management, Sultan Chand. 

4. Sherlekar,  Business Organization and Management, Himalaya 

Publications. 

 

 

 

 

 

 


